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The Palmer notation system and its use with
personal computer applications
J. W. Ferguson1

The arguments for and against the Palmer dental notation system are briefly discussed, including the perceived difficulty of
reproducing this on personal computers. Some technical solutions to the problems encountered in everyday Windows-based
programs are outlined, with suggestions as to possible future applications. 
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INTRODUCTION
There has been much debate in the
columns of this and other journals regard-
ing the merits or otherwise of the various
tooth notation systems currently in use.
Two methods which will be familiar to
most UK dentists are the Palmer and the
FDI systems. Several authors have come
out strongly in favour of the FDI system1-3

and have encouraged the international
dental community to adopt this as the sole
method. However, this does not seem to
have gained widespread acceptance, at
least within the United Kingdom.
Blinkhorn et al.4 found that only one UK
dental school actually instructed its stu-
dents to use FDI notation as standard but,
despite this, most of the practitioners
referring patients to that institute still
seemed to prefer the Palmer method. 

One advantage of Palmer notation is
that it can produce a very graphical image,
akin to a ‘map’ of the dentition; tooth
transpositions or edentulous spaces can
easily be depicted if desired. It would also
be feasible to introduce additional alpha-
betic characters or other symbols, for
example to denote supernumerary teeth or
bridge pontics, to which a purely numerical

method such as the FDI system does not
lend itself easily. There is a perceived prob-
lem, however, with reproducing Palmer
notation on computers. Indeed, in view of
these difficulties, the British Dental Journal
itself requested a change to the tooth nota-
tion system to be used by prospective
authors.5 Nevertheless, as stated above, it
still seems to be popular amongst UK prac-
titioners, and thus it would seem logical to
try and resolve the technical issues sur-
rounding computer replication, particular-
ly word processing. Some possible solu-
tions for incorporating Palmer notation
into word processed documents and other
applications are thus described below.

Word processing 
One solution was proposed by Lewis,6

using the Microsoft Word equation editor
function. This was primarily to deal with
the problem of lower tooth characters
which require an overline, the upper teeth
simply being underlined and right/left
separated thus. It required several key-
strokes, although it was possible to auto-
mate the process to a large extent by the
use of a macro function.

Another way to generate the overline is
simply to include this as part of a bordered
table inserted within the document. In
Microsoft Word, this can also be saved as
an autotext entry, a blank table being
entered where required and the necessary
teeth entered in the appropriate table cells
from the keyboard. The table needs to be
so designed so that the visible borders (that

is, those that will actually print) are
restricted to the appropriate cell bound-
aries. The major disadvantage is that it is
not possible to incorporate a table on the
same line as normal text, therefore careful
composition of the document is required to
make the text flow. An example of how
this might be used is shown in Figure 1.

The use of bespoke fonts is potentially
the most versatile solution. McCormack7

originally described the use of dedicated
fonts which could be used in dentistry. He
demonstrated how specialised font cre-
ation and modification software (Fontog-
rapher version 4.1; Macromedia Inc., 600
Townsend Street, San Francisco, CA
94103: www.macromedia.com) could be
used to produce images of teeth, implants,
etc which could then be incorporated into
documents. A logical extension of this was
to produce a font in which the individual
tooth numbers and letters could be depict-
ed in Palmer format, with the relevant
lines placed over/under and right/left of
the number or letter itself.8 The present
author has been using such a font
(designed by John McCormack) for several
years now. A further refinement, which the
present author has recently developed, is
to create characters without left/right
dividers, but to store the latter as separate
symbols. This enables continuous charting
of a given quadrant, and is the format in
which most people would choose to write
Palmer notation longhand. Examples of
the text that can be produced with spe-
cialised fonts are shown in Figure 2. 

 Palmer dental notation can readily be reproduced in word-processed documents by the use of
bespoke font characters.

 The same method also has scope for use in other common software applications that support
the use of multiple fonts.

 Users of Microsoft Windows XP™ can create the required specialised characters without the
need for additional imported fonts or font creation software.

 Electronic transmission and viewing of documents is also feasible, provided that the recipient
computer is suitably configured, or the sender embeds the font within the document.
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As mentioned above, creation of such
fonts normally requires the use of specific
software. Those using the Microsoft Win-
dows XP operating system, however, can
create their own Palmer notation characters
with a little-known function called Private
Character Editor (PCE) which is already
included with the software. A description of
the procedure is given in the appendix.
However, whereas a freestanding font gen-
erated with proprietary software can be dis-
tributed and installed on any personal com-
puter, PCE characters cannot be exported.
This is of no consequence if the user simply
wishes to produce hard-copy output, but
has implications for the electronic trans-
mission of documents (see below). 

For a typist wishing to enter Palmer
notation, there are two options. One is to
manually switch fonts when a section of
document requiring such notation is
reached, the other is to store the characters
as autotext entries which are assigned to
buttons on customised toolbars (see Fig. 3
and appendix). Clicking on the button then
inserts the character, in the correct font,
with automatic reversion to the default
font selected for the document when nor-
mal keyboard entry is resumed.

Other Microsoft applications
The above method can also be used for
other products in the Microsoft range,
including PowerPoint, Publisher, Front-
page and Wordpad, which also support the
use of multiple fonts within the same doc-
ument. The main difference is that it is not
possible to create toolbars for rapid char-
acter entry as with Microsoft Word. Never-
theless, as the vast majority of users who
may wish to use fonts in other programs

would also have Word installed, it is a sim-
ple matter to generate the required text,
copy and paste it into the desired applica-
tion. With PowerPoint, all of the text may
default to that selected for new text objects
within that document, but the relevant
sections can be selected and manually
altered to the required font. 

Microsoft Access (a relational database
program) is a special case: a detailed discus-
sion of the possible variations in database
design, and how best to record the dentition,
is beyond the scope of this article. However,
printed outputs (reports) may be required
which will have the same visual format as
word-processed documents. The simplest
option is, of course, to create a separate data
field for each quadrant, in which case stan-
dard alphanumeric characters, correspon-
ding to the Palmer numbers or letters for the
required teeth, can be entered in that field
direct from the keyboard. Input forms and
reports are then set up with the relevant
fields oriented correctly from the perspec-
tive of the user, with quadrant dividing lines
constructed on these forms or reports using
the toolbox function. This will produce an
output comparable to a bordered table in
Microsoft Word. There is a specific problem
if one wishes to include descriptive text
along with dental notation within the same
database field, as each field can only display
a single font. The solution is to use a font
which contains regular text and punctua-
tion in addition to the specific dental char-
acters. The author uses both methods within
his hospital clinical database.

Electronic transmission of documents
The ideal situation is for the recipient to
have the relevant font installed on their
computer, which will allow any document
to be viewed and edited if required. Plain
email texts can also contain multiple fonts,
which will often display correctly on the
receiving computer if the above conditions
are satisfied although, in the author’s expe-
rience, this is not always reliable. For
potential recipients who are unlikely to

have the font installed, electronic trans-
mission of the font file together with the
message is perfectly feasible, and installa-
tion is straightforward. Microsoft Word
and PowerPoint have an option to embed
fonts within the document (see appendix),
thus allowing them to be viewed even if the
recipient’s computer is not set up appropri-
ately. Once again, in the author’s experi-
ence, this works reliably in Word 2002, and
also Word 97, but not in earlier versions.
The above options are not applicable if the
characters have been created using the Pri-
vate Character Editor function in Windows
XP, but if the receiving computer is also
running Windows XP it is possible to con-
figure it with identical characters. Editing
of documents with embedded fonts is not
possible, but may not actually be necessary
or desirable (for instance, for an electronic
referral). A further option, which would be
appropriate for small documents, is to send
them as graphic files; this format would, in
any case, be required for radiographs and
clinical photographs. Files can be created
either by scanning or using the ‘Print
Screen’ function; if the ‘Full Screen’ option
is selected from Word’s ‘View’ menu, all
menus and toolbars are hidden and not
included with the screen clip. The graphic
can be copied, pasted into another docu-
ment, and also saved as a separate file.
Windows XP can save these clips as .JPEG
files, which are of a much more manage-
able size than standard bitmaps. Finally,
web-based documents or journals could
incorporate Palmer notation if desired, as it
would be perfectly feasible to provide for a
simultaneous download of the font from
the publisher’s website.

Other potential applications
These could include databases for electronic
patient records, which are likely to become
the standard of the future, and developers
of such systems could consider incorporat-
ing Palmer-type fonts as part of any 
specialised functionality developed for the
dental field. Such databases may also 

Fig. 2  Text produced using specialised font
characters. The upper line shows the effect using
a font with tooth numbers/letters simply
underlined or overlined, separate characters being
used to divide left and right quadrants. On the
lower line, each individual tooth is depicted by a
unique character. 

Fig. 3  Microsoft Word screen set up with customised toolbars to permit continuous charting, using the
character set illustrated in Figure 6. Clicking on the button text inserts the symbol into the document.
Four toolbars are used, arranged on screen to mimic the Palmer grid. The toolbars for the deciduous
teeth (which also include suggested additional symbols for supernumerary teeth, pontics and spaces
within the dentition) have been placed above and below those for the permanent teeth. The button
images for the quadrant starters, finishers and dividers are coloured for easier identification. The
corresponding tooth symbols to left and right of the dividers do, in fact, insert identical autotext
entries; the layout chosen is simply to make the screen more intuitive.

Fig. 1  A table inserted into a document to
facilitate Palmer-style notation. The thick lines
(which have been exaggerated for clarity) would
appear in print, the thinner lines representing
those table cell borders which are only visible 
on screen.
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incorporate clinical coding systems, but if
reference to specific teeth is required it
would be far more appropriate to include
these in a separate field and not as part of
the diagnosis or procedure code itself. For
example, using the OPCS-4 codes (employed
in the author’s hospital) for descriptions of
dental procedures, it would clearly be
unworkable to devise separate codes for all
possible combinations that might be cov-
ered by even one of the existing codes (F104,
extraction of multiple teeth). 

Summary
The fact that previous research4 has suggest-
ed that Palmer notation is still the preferred
system amongst UK graduates argues
favourably for its continued use, especially
as the technical problems in reproducing it
in word-processing and other software
packages are surmountable. Electronic com-
munication between practitioners would be
facilitated by the widespread dissemination
of the required specialised fonts within the
dental community, and an agreed standardi-
sation of the character codes for those wish-

ing to use the existing font editing function-
ality within Windows XP.

Appendix
Creating dental symbol characters using Windows
XP Private Character Editor (PCE)

Below is a brief description of how to use this
function; full instructions can be found in the
Windows ‘Help’ files (enter ‘PCE’ in the Search box
which should display ‘Using Special Characters’: click
on ‘Related Topics’ and follow the links.)

1. Click on ‘Start’, then ‘Run’.

2. Type in ‘eudcedit’ (without the quotation marks). 

3. This opens the PCE window with the ‘Select Code’
screen displayed (Fig. 4).

4. Double-click on one of the squares in the selection
grid which will open the bitmap editing window for
that character space.

5. Copy the outline for the required alphanumeric
character by selecting ‘Copy Character’ from the ‘Edit’
menu.

6. Then, using the filled rectangle tool (black square)
from the toolbar on the left hand side of the screen,
create the required over/underlines or left/right
divider lines as required by dragging over the required
pixels. A line thickness of four pixels should give an
adequate on-screen display (Fig. 5).

7. Any mistakes can be rectified by using the eraser
tool, at the foot of the toolbar.

8. Select ‘Save Character’ from the ‘Edit’ menu, or ‘Next
Code’ from the ‘View’ menu.

9. To view the complete character set, or select
another character code which does not immediately
follow or precede the current character in sequence,
choose ‘Select Code’ from the ‘Edit Menu’ again.

Inserting characters into document

Characters created using PCE can be found under
‘All Fonts (Private Characters)’ in the character map
font list box (Fig. 6). They cannot be inserted directly
from the keyboard. They can be selected and copied
into a new blank Word document, from which
individual autotext entries can be created and
assigned to custom toolbars. Instructions for
accessing the character map, creating autotext
entries and custom toolbars can be found in the
Windows or Word help files. Autotext entries can
also be created from installable fonts, although in
this case it is also possible to arrange the encoding
layout such that they can be entered by logically-
arranged keystrokes (eg unshifted numbers and
letters for lower teeth, shift key plus same
characters for upper teeth, etc.)

Embedding True-Type fonts

1. From the Word or Powerpoint ‘Tools’ menu select
‘Options’.

2. Click the ‘Save’ tab.

3. Under ‘Save Options’, check the box captioned
‘Embed True-Type Fonts’.

4. Note that in Powerpoint the embedding option
applies to the current document only.

The author particularly wishes to thank John
McCormack for his invaluable help and assistance,
and to acknowledge his original idea of using
specialised fonts for dental iconography. Thanks
are also due to Sharon Bradley for her assistance
with drafting the manuscript and providing an
end-user perspective with regard to integrating
specialised fonts into word-processing
applications.
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Fig. 4  The PCE code selection grid,
showing part of a character set
created to allow both continuous
charting and also insertion of
unique characters for each
individual tooth. Hidden rows are
displayed using the vertical scroll
arrow. The unique (hexadecimal)
reference code for each character is
determined by its position at the
row/column intersection. 

Fig. 5  The PCE editing grid; the arrow shows the
filled rectangle tool, which has been selected
and dragged over the requisite number of pixels
to insert the underline. The number ‘3’ has first
been pasted into the grid by using the ‘Copy
Character’ function, which is accessed via the
‘Edit’ menu.

Fig. 6 Character map window showing private
characters created with PCE. Select ‘All Fonts
(Private Characters)’ from the font list box to
display this character set.
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